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Introduction
Welcome to Book Librarian for Windows. Book Librarian is a fast easy to learn and use database 
manager that will help you to organize and keep track of your books. It is ideal for managing a 
personal, professional, church, club or business library.    With this program you can quickly search 
your library and print reports to the screen or printer. You can also keep track of who has books 
checked out and when they are due for return. The program will also generate and overdue list.



Customer Support
Note: Customer support is only provided to registered users. We will provided limited support to 
unregistered users such as helping to resolve installation problems.

We have made the program as easy to use as possible. However, if you have a problem and find the 
documentation and help inadequate, we would like to hear from you. We reserve the right to end free 
customer support four months following the purchase date. We reserve the right to terminate 
customer support for any person who uses profane abusive or harassing language or who at our sole 
discretion abuses customer support. If we elect to terminate your customer support we will issue you 
a refund of the registration price, less any shipping/handling fee. You can reach us by mail at:

TurboSystemsCo
P.O. Box 965368

Marietta, GA 30066-0007

You will get faster service from us via electronic mail or FAX.

Compuserve ID: 72427,1603
Prodigy ID: RXJX53A.
GENIE ID: L.TURNER1
AOL: LemT
EMAIL: rxjx53a@prodigy.com
FAX: 770-591-4988

As a registered user of Book Librarian, you are entitled to telephone support. Feel free to call us with 
your questions at 770-516-8575. Telephone support hours are 11am-4pm eastern time Monday-
Friday.



Satisfaction Guarantee
If you register Book Librarian for Windows, TurboSystemsCo provides a 30 day no questions asked 
money back guarantee. If not satisfied with the program or service for any reason, just return the 
complete program package within 30 days of the invoice date for a full refund less shipping and 
handling fees.



Data Operations
Data operations allow you to add, edit, delete, undelete, copy and save records. All the operations 
are selectable from the tool bar or main menu.

Click the Add Button on the tool bar to create a blank record to type in your information. You can 
move from field to field by using the [Tab] key or buy using the mouse. Press the Save Button to save 
the information to disk.

The Delete Button marks the currently displayed record as deleted. The record is no longer 
displayed, but is stored on disk. Prior to packing the database, the record can be restored by use of 
the Undelete Button.

The Undelete Button is used to undelete a record previously marked for deletion. This must be used 
in conjunction with the View Menu item on the Main Menu.    Select View Menu then Deleted 
Records. The records previously marked for deletion can be undeleted.

The Copy Button makes a duplicate record of the displayed information. This is useful when adding 
records where the information is almost identical.

The Save Button writes the displayed record to disk. After adding, editing or copying, the button must 
be clicked to save the data.

Editing a Record

To edit a record use the mouse to place the cursor in the field you want to change, make the 
changes then click the save button. You can also use the [Tab] key to move to the field you want to 
change.

Input Fields

The program has fields for Title, Book#, Author, Subject, Type, Catalog#, Subject2, Subject3, ISBN, 
Condition, Edition, Pages, Price, Value, Copyright, Loaned, Borrower, Due-Date, Publisher, Location, 
Tag, Note1, Note2, Purchase Date. There is also a 32,000 character memo field.



The fields for Author and Borrower are single fields that hold the first and last names. The fields 
should be entered; Last Name, First Name. For example:

                      Author:Kennedy, John F.                  Borrower:Turner, Lemuel D.

The Book_Num field is automatically assigned a unique number by the program (autoincrementing), 
however you can edit and change this number as long as it remains a unique number



Browse Query
Several ways are provided to browse and query your database. Four Button Keys are provided to 
allow you to browse from the data entry screen.    The Find Button is used to search for information 
on one of the index fields which is extremely fast. The Query Button allows you to perform complex 
searches on all fields.

Browsing

Moves the database to the first record in the database based on the primary index selected.

Moves the database to the last record in the database based on the primary index selected.

Moves the database to the previous record in the database based on the primary indexed selected.

Moves the database to the next record in the database based on the primary index selected.



Find A Record

Click the Find Button to locate an item by TITLE, AUTHOR, SUBJECT, BOOK#, CATALOG#, or 
TYPE. When the button is clicked the Find Window is displayed.

Enter the value you want to search for in the Text Box. If an exact match is found, the item is 
displayed in the Data Entry Window

If multiple matches are found, a pop up Browse/Choose Window is displayed with the cursor placed 
on the first item that matches. If no match is found the cursor is placed on the item that is the nearest 
match.

The Browse/Choose allows you to browse through the database and choose any item for display in 
the Data Entry Window

NOTE: The search value entered for all fields except Title is case insensitive, i.e. you can enter the 
text in upper or lower case or a combination of the two.    However the search text for the Title field 
must be entered in all uppercase for the find procedure to work on the Title field.



Query

While the Find Button can only search on one index field, the Query Button    allows you to perform 
complex searches on any combination of fields. When the button is clicked the Query Window is 
displayed.    The Query Window allows you to enter various selection criteria which will create a 
subset of the main database. In the Query window you can select the Index order you want the 
resulting query displayed. You setup your search criteria in the window then press the Apply Button

Click the OK button and a record set is created that meets the search criteria. This record set is a 
working subset of the original datafile. You can perform all program operations on this subset just like 
working with the complete datafile. The Query does not create a new file, it just limits the records that 
are displayed. If you change a record in the query subset you are changing the original datafile.

Click the Reset Button on the toolbar to restore the complete datafile. You can also Save/Recall 
Queries to disk by selecting the File from the Query window.

The Remove Button removes the highlighted query condition    from the Query window.

Query Operators
Listed below are the operators that can be used in a query. The operators 
below are case sensitive. This means that when you enter a search value it 
must be entered in the same letter case as the value in the database. If 
the word you are looking for is stored in the database as Lovely, entering 
lovely or loveLy as the search value would not produce a match. Only 
Lovely as the search value would produce a match

       Operator             Meaning

            =                 Must be equal to
            <>                Not equal to
            >                 Greater than
            >=                Greater than or equal to
            <                 Less than
            <=                Less than or equal to
            CT                Contains
            NC                Does not contain

NOTE: The tag field is a logical field with a value of True or False. On screen the Tag field is true 
when the Tag field has a checkmark and false when the field is empty. In the Query function true and 
false are represented by a 1 (true) and a 0 (false).    So if you wanted to locate all records with the 
Tag field check marked, i.e. true, you would enter the following on the Query screen.

                                                        TAG = 1

In the Report Module Query, you must actually use the words true and false in a query instead of 1 
and 0 as used here.    The Report Module Query is completely independent of the program module 
described here. The Report Module allows you to perform more complex searches using wildcard 
characters, logical operators (and, or) and by use of parentheses.

All Query conditions in the program query module are joined as if using a logical "and", i.e. all listed 
query conditions must be true for a record to be selected.



Query Fields
There are three fields in the Query window used to set up the search criteria. There is one additional 
field in the Query window Order By which is used to set the index order in which the query is 
displayed, ie TITLE, BOOK#, AUTHOR, SUBJECT, TYPE, CATALOG#, or BOOK#.

Field        The Field box holds the list of fields that 
             can searched.

Operator     The operator box holds the comparison
             operators explained earlier (<, <>, etc.)
             This field specifies how you want to compare 
             a field to a constant, i.e. do you want the
             field to be equal to or greater than the
             constant.

Constant     Enter the value to be compared to the field
             selected.

Query Buttons
Add          Adds a query condition to the query box.
             Example (SUBJECT = MILITARY)

Remove       Deletes the highlighted query condition from
             the Query box.

Apply        Performs the query operation using the query
             conditions listed in the query box.

Close        Closes the query window and returns to the
             main program. 

Query Examples



Listed below are several examples for setting up query conditions:

Field    Operator          Constant
Author       =                 Kennedy,John F.

The query would select all books in the database written by John F. 
Kennedy. 

Field    Operator          Constant
SUBJECT      =                 War
YEAR         >                 1970

The query above would select all books in the database that the subject 
was war and was written after 1970.

Field    Operator          Constant
TITLE       CT                love

The query above would select all books in the database that contained the 
word love somewhere in the title field. 



Reports
The report system is extremely easy to use.    First select Reports from the Main Menu. This provides 
a full list of reports you can select. Next you will be presented with a dialog that will allow you to print 
all or selected records. Next you are presented with a dialog that allows you to choose the output 
location for the report, screen, printer or text file.

Report Types
Title           Lists Title, Author, Subject, sorted by
                Title

Author          Lists Author, Title, Subject, sorted by
                Author

Subject-1       Lists Subject, Title, Author, sorted by
                Subject

Subject-2       Lists Subject, Title, Author, Catalog#,
                Book#, sorted and grouped by Subject

Book Type       Lists Book Type, Subject, Author, Catalog#
                Book#, grouped by Book Type.

Catalog/Memo    Lists all fields including the memo field
                and is sorted by Title.

Catalog         Same as above, but does not include memo.

Valuation       Lists Title, Book#, Pur-Date, Pur-Price,
                Current Value. Computes percentage change
                between Pur-Price and Current Value for
                each book. Totals Purchase Price and
                Current Value. Sorted by Title.

Borrower        Provides a list of all people who have 
                books out on loan. Lists Borrower, Title,
                Due Date and the status of the book, i.e.
                is it overdue. Sorted by Borrower.

Overdue         Provides a list of all overdue books.

Index Cards     Includes all fields except memo. The cards
                are sorted by the type card selected;
                Title, Subject or Author.

Library Cards   Similar to above, but printed in library
                format.

NOTE: The index and library cards listed above can be printed on card sheets (3 cards per sheet) for 
laser and inkjet type printers or on continuous form cards. The card sheets used by this program are 
Avery product number 5388 or compatible. The size of each individual card is 3" x 5". The continuous 
from cards required for dot-matrix printers are 3" x 5". When you select Index or Library Card, you 
will then select Laser or Dot-Matrix for card sheets or continuous form cards.



Report Query Dialog
After you've selected the Report Type you want to print, the Insert Selection Rule dialog is 
displayed.

To Print all Records
Click the OK button on the Insert Selection Rule dialog.

To Print a Subset of all Records
The Book Librarian report module includes a full report filtering/querying system to allow you to enter 
selection rules called a query to select a subset of records to be listed. Once you define a query only 
those records meeting the selection criteria is printed.

Building the query structure is explained in the following topics: (1) Query Structure; (2) Developing 
and modifying a Query; (3) Query Techniques.

Comparison Operators

Operator               Field Is

equal to                 Equal to entered value or
                         selected fields value.

not equal to             Not equal to entered value.

greater than             Greater than entered value.

greater than or equal to Greater than or equal to entered
                         value.

less than                Less than entered value.

less than or equal to    Less than or equal to entered 
                         value.

in the range             Between two entered values or
                         equal to either.

not in the range         Not between two values and equal
                         to neither

in the list              Equal to one of the listed values
                         (up to 10 values)

not in the list          Not equal to any listed values
                         (up to 10 values)

NOTE: The list of comparison operators depends on which field you select from the Field List box.    
For example if you select TAG (a logical field)    only "equal to", and "not equal to" are    displayed in 
the Comparison list.

Comparison Values



Depending on the field and operator you have previously selected, the value can be:

1 A field of the same data type as the field you selected.

2 A constant value such as a number or character string. Enclose character strings in quotation 
marks (single or double) or square brackets; enclose date constants in curly braces -- for 
example {12/31/1995}

3 If you have selected "equal to", "not equal to", "in the list", or "not in the list", a pattern using * 
and/or ? as wildcard characters.

4 A list of constant values, any of which can be a character string including wildcards. Separate the 
items in the list with commas.

5 A pair of constant values that define a range.

NOTE: The comparison value can have a maximum of 530 characters.

Entering Values in a List
If you select "in the list" or "not in the list" as the comparison operator, you can enter multiple 
comparison values. Separate the items with a commas.

Defining a Range of Values
If you select "in the range" or "not in the range" as the comparison values, separate the values with a 
comma. Neither value can be blank.

Report Destination Dialog
The Report Destination dialog is displayed after you click the OK button on the Insert Selection Rule 
or Query dialog. The dialog allows you to select the location for the report; Printer, Screen, Export 
(file)

Printer
If you select printer the report is generated and sent to the default windows printer. A dialog box is 
displayed during the report generation. Click the Cancel button to stop report generation.

Screen
When you select the screen option, the report is generated and displayed in the Print Preview 
window. You can zoom the display by clicking the desired location on the preview page. The zoom 
level and positioning are maintained as you page through the report.

You can use the Preview Buttons to move around in a multi-page report, to close the Preview screen 
and return to the main data entry screen. The buttons can accessed by clicking the mouse or by 
pressing the applicable function key. Starting from left to right (as displayed on the screen), are 
explanations for each button:

Button              F-Key  Purpose



Print                 F1    Prints complete report.

Print Current Page    F2    Prints currently displayed
                            page.

Zoom In               F3    Magnifies print preview.

Zoom Out              F4    Returns to previous size.

First Page            F5    Displays the first page. 

Previous Page         F6    Displays previous page.

Next Page             F7    Displays the next page.

Last Page             F8    Displays the final page.

Pause                 F9    Pauses preview when moving to
                            the last page. 

Close                 F10   Closes preview window and
                            returns to main program.

Export
The report module has the potential to export data to (1) Text file; (2) Xbase file; (3) Excel 5.0 chart; 
(4) Excel 5.0 PivotTable; (5) Rich Text Format (RTF) file; (6) Text Data File; (7) Word Merge File; (8) 
Worksheet file.

In this implementation only item (1) export to Text file is supported. In the Shareware version export 
is not supported at all. With the registered version the WinImpex program is included which will 
export data in xbase and Text Data format.

When you select Export from the Report Destination Dialog, the Export Dialog is displayed listing the 
eight export formats listed above. As stated earlier, only Text file export is supported. If you select 
any of the other seven export types you will receive an error message.

Exporting to a Text File
This option will export data to an unformatted text file. Exporting to a text file is useful if you plan to 
include report data in a word processing or desktop publishing document.

To export data to a text file:

1 On the Export Dialog highlight "Text" in the list box and select edit.

2 The Text Export dialog displays. In the File Name box enter a file name, optionally a path and a 
file extension. If you do not include a path, the program creates the file in the program directory.

3 Choose the option you want in the Text File Options box:
Select either Windows (ANSI) or DOS (PC) character set. In general you should select Windows 
(ANSI) if you plan to import the data into a windows program. Select DOS (PC) if you plan to 
import the data into a DOS program. In the carriage returns box, either Every Line (insert a hard 
return after every line in the report) or Once per band (a hard return after the report heading, 
then after all report data on a page and then after the page number).

4 To generate the file select Export



Main Menu
The Main Menu provides a means to access and perform all functions required by the program. Most 
of the functions can be performed from the Toolbar.    To access the Main Menu without a mouse, 
press the F10 function key. To select a menu item without a mouse, press ALT+ the underlined letter. 
There are a few functions such as ReIndex that can only be accessed from the Main Menu.

File Menu
The Open Menu displays Data Entry 

Edit Menu
The Edit Menu displays the standard windows items for copying, pasting and cutting information to 
and from the clipboard. Highlight a field and select the appropriate item.

Record Menu
The Record Menu provides the same functions that can be accessed from the Toolbar.

Tools Menu
The ReIndex | Pack menu items displays the ReIndex Window that allows you to select the files you 
want to reindex. In addition to rebuilding the index files, the Pack item removes the records marked 
for Deletion Button from the database.

Once the database is packed, the records previously marked for deletion cannot be Undeleted. You 
should reindex the database if you notice that records are not being displayed in the correct order.

Reset Book# -- sets the auto incrementing counter for the book#    field to the number + 1 displayed 
in the book# field.    Normally the only time this is needed is after importing records into the database. 
And normally should be set to the largest book number.    The largest book number can be 
determined by setting the index to Book_Num and then pressing the Last button on the toolbar.

View Menu
The Index Order allows you to select the index order that the items are displayed when the First, 
Last, Next and Previous keys are accessed.

Natural Order displays the record in the order that they were entered in the database.

Query Order displays the items in the order selected on the Query Screen when building the Query.

Deleted Records displays the records marked for deletion by the Delete Button. The records 
displayed can be Undeleted so they can be displayed normally again.

REPORTS

Windows
Allows you to arrange the displayed windows in standard windows formats.





Order Form
Select Print from the File menu to print this form to your printer. Complete the form and mail or fax to 
TurboSystemsCo.    Credit card orders can be placed by calling 1-800-257-7221 or fax to 1-770-591-
4988. If you are a Compuserve member you can order through SWREG.

Order Date:______________________________________________

      Name:______________________________________________

   Address:______________________________________________

   Address:______________________________________________

      City:___________________________ St/Prov:__________

   Country:___________________________

     Phone:_____________________ Fax:____________________

Source of Shareware:_____________________________________
Payment Method: Check[ ]  Visa[ ]  MasterCard[ ]
          Money Order[ ]  Amex[ ]

Card Number:_____________________________________________

Exp Date:(Month/Year:____________________________________

Signature:_______________________________________________
    signature required for credit card orders only.

               Products click for product descriptions

[ ] Book Librarian Single-User                     $25.00
[ ] Book Librarian Single-User with Password       $40.00 

[ ] Book Librarian Multi-User                      $75.00
[ ] Book Librarian Multi-User with Password        $90.00

                                 Product Amount$ ________

Shipping/Handling             Shipping/Handling  ________ 
US/Canada    $4.00                   *Sales Tax  ________
All others   $8.00
                                          Total$ ________

* Sales tax applies to residents of Georgia only. If you 
are a resident of Georgia add 5% of the Product Amount on 
the sales tax line.

Credit Card Orders Via Phone       Mail Orders 
1-800-257-7221                     TurboSystemsCo
1-770-516-8575 (International)     P.O. Box 965368
1-770-591-4988 (FAX)               Marietta, GA 30066-0007



Program Descriptions
There are four different versions of Book Librarian available. The different versions are described 
below:

Book Librarian Single-User: program for use in a non-network environment. Data files can only be 
accessed by one person at a time.

Book Librarian Multi-User: program designed for use in a network environment. Data files can be 
accessed by up to 25 people at one time. This version can also be used on a stand alone computer. 
If you need to allow for more than 25 users, contact us for pricing.

Password Protection: This feature can be added to both the single and multi user versions. Each 
person must have a password and a security level assigned to enter the program. Security levels can 
range for 0 to 9. In the password version to Add, Edit or Delete data, a person must have a security 
level of 3 or higher. So if you want to allow someone access to the program without being able to 
Add, Edit or Delete, you would assign them a security level of 0, 1, or 2.

NOTE: This evaluation copy of Book Librarian is the multi-user version. There is no operational 
differences between the two versions other than the single-user version can only be used by one 
person at a time.

Order Form



Benefits of Registration
As a registered user of Book Librarian you will receive the following benefits:

1 License to use the program indefinitely.

2 Printed documentation.

3 Latest version of the program without the shareware notification screen.

4 Free technical support via phone (not toll free), mail, FAX, Compuserve, AOL, Prodigy    or e-
mail.

5 A conversion program to convert Book Librarian for DOS data for use with this program. Note: 
the conversion program only transfers the first four lines of the DOS memo field to the Windows 
memo field. This is because the windows memo is limited to 254 characters in this version. All 
other fields are transferred.

6 A program to import/export dBase and ASCII data to and from Book Librarian.

7 Discounts on other programs and products.

8 Notification of major upgrades.

9 Low cost upgrades.

Order Form



Copyright Enforcement
Under our copyright we have granted you permission to evaluate this program up to 30 days without 
payment    to us.    If you continue to use this program after 30 days you must register the program by 
paying the appropriate registration fee.    If you decide that this program does not meet your needs 
and do not wish to register the program just run the included Uninstall program to delete the program 
from your hard drive.

We also provide you a Satisfaction Guarantee that allows you to use the registered version for 30 
days without risk.

This program is fully functional. However if you continue to use the program after 30 days without 
registering (a violation of US Copyright Law , which is punishable by fines and/or imprisonment), the 
functions of the program will be limited at some point after 30 days.

Continued use after 30 days will eventually result in the inability to Add, Edit or Delete Records. You 
will also lose the ability to print reports and re-index the database.    This functional loss will start on 
day 31 or later. The actual date that the reduced functionality takes place depends on how much you 
have used the program.

NOTE: We can not provide you with a registration key over the phone or via e-mail to turn the 
functions back on. You must get a new disk from us via mail to enable full use of the program. Please 
take this in consideration when deciding at which point to register.

The data is stored in standard dBase IV format which can be imported or used by most database 
programs. 
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SWREG
If you are a member of CompuServe, you can register Book Librarian on CompuServe by going to 
the Shareware Registration forum (GO SWREG). Enter the SWREG ID# (see below) for the program 
that you want to order. The product cost will be charged to your CompuServe bill. CompuServe will 
notify us of your order via e-mail and we will ship the program to you via mail.

PROGRAM                                   SWREG ID#

Book Librarian Single-User                        9441
Book Librarian Single-User with Password          9443

Book Librarian Multi-User                         9444 
Book Librarian Multi-User with Password           9445

Order Form



Book Librarian Multi-User with Password
Same as the multi-user version, but adds a password security system to limit access to authorized 
individuals.



Book Librarian Multi-User
Program designed for use on a network. Data files can be accessed by up to 25 people at one time. Can 
also be used on a stand alone computer.



Book Librarian Single-User with Password
Same as single-user version but adds a password security level system to limit access to authorized 
individuals.



Book Librarian Single-User
Program for use in a non network environment. Data files can only be acessed by one person at a time.






